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What is computer control?
Many types of technology can be controlled, including mechanisms and electrical 
components. Computer control provides unique opportunities for pupils to develop 
elegant and precise solutions in a simple way. The idea of pupils using a computer to
control can appear daunting but in reality when Flowol software is used it is a surprisingly
easy rewarding and creative process.

At its simplest, computer control involves using a computer to control electrical devices
e.g. lights, buzzers and motors. This may also involve the use of switches as input
devices. An interface box, such as FlowGo, is required to interpret the information given
to and from the computer and provide the right amount of power for the electrical
devices. 

It is important to remember that it is we that control the technology, and not the other way
around! Most of the technology that we use everyday is simple to control e.g. using
knobs and switches to turn things on and off. For those of us involved in educating pupils
about control, this is the place to start. The most basic of these involves using a simple
switch to control a bulb.

Why use a computer?
Lights, motors and buzzers can easily be controlled by simple on/off switches, magnetic
and tilt switches, mechanical timers etc. Why do we need to use a computer? 
What makes using a computer better?

Accuracy – especially timing (and positioning)
Capability – controlling more than one thing at once
Power control - motors
Sensing -  the environment
Using feedback - so that it is a two-way system
Memory – storing and playing back a sequence of events
Repeating actions – continuously or for a fixed number of times.

Relevance to modern day life
Computer and microprocessor-controlled systems play a significant role in our lives, from
traffic management systems and automatic doors to cuddly toys that demand attention. In
the modern industrial world, the ability of computers to repeat both easy and complex
instructions precisely and endlessly is harnessed to control production lines and to control
manufacture to ensure quality products at an economic cost.  It is not surprising therefore 
that increasing attention is being given to computer-aided design, computer-aided 
manufacture and computer control in design and technology education. A control system
is only as good as the person who has designed it! Computer control could be referred to
as an invisible technology - you don’t notice until it breaks down!

BulbBattery Pack

Switch
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Computer control and the curriculum
There is long history of using computer control in education. Since the 1960’s the 
programming language LOGO has been used to control ‘turtles’ on the computer screen
and small manoeuvrable robots. Apart from the ability to enable children to move a ‘turtle’
around, LOGO has a very important role in developing problem solving and thinking
skills. Importantly it allows children to ‘teach’ the computer new things and act upon 
feedback given from the computer.

Whilst LOGO is relatively easy to use when moving simple ‘turtles’ on screen it can
become complex when controlling a series of motors, lights and buzzers. It has only been
since the advent of software that uses flowcharts, such as Flowol, that children of 
primary age have had real access to computer control.

Currently, computer control is one of the main areas of overlap between Design and
Technology (D&T) and Information and Communication Technology (ICT). The present
National Curriculum for Design and Technology in the UK includes the use of computer
control for children of primary age in both the D&T and ICT Programmes of Study. Now,
for the first time, all children are entitled to have experience of using control technology
from a young age.

Computer control for a purpose 
It is particularly important, with control in design and technology, that a clear purpose for
the control activity is established. If the aim of the activity undertaken with children is just
to learn how to use the software then it is effectively ICT skills that are being taught.
Enabling children to explore a context where a control outcome might be useful will make
sure that the software is used as a tool and not just an end in itself. It is where children
control a product that they have researched, designed and made that the real links
between D&T and ICT are exploited.

What do pupils need to know before starting computer control?
Pupils need two sets of skills:

1. The ability to put together a simple electrical circuit e.g. how to wire up a bulb so 
they can apply lighting to a model.

2. An understanding of the terminology (sequence of instructions) and the meaning of 
flowchart symbols. This could be a progression of work started with Learn & Go, 
LOGO or Roamer. The Flowol mimics could be used to learn how a program is 
created to perform a sequence of instructions – see Zebra Crossing, and Bridge 
Lights.

What skills do pupils learn from computer control activities?
Firstly, pupils learn to use the computer for a purpose. At its simplest, pupils learn that
computers are not magical and that they need precise instructions in order to perform a
task.  
Secondly, designing a control system means that pupils are involved in problem solving,
and logical thinking.
Lastly, pupils will discover that there can be more than one correct answer
See Key Skills on page 36. 
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Computer control in everyday life
Do your pupils recognise control systems when they see them? Ask them to describe
what control systems they have used or experienced on the previous weekend. Their
experiences may include:

• Traffic lights or pedestrian crossing lights
• Video recorder or interactive T.V.
• Automatic doors at a shopping precinct, supermarket conveyor and bar code reader
• Vending machines for drinks or sweets
• Household appliances e.g. microwave, freezer, fridge, automatic washing machine, 

or dishwasher.
• Car park barriers, football ground barrier, bus or train ticket machines etc.

Now establish what is common to all of these systems – press a switch, the machine
does what it has been 'taught', using a combination of motors and mechanisms, lights
and sounds.

Classroom Organisation
Using the I.T. Suite for whole class/large group teaching
Programming skills and a basic understanding of computer control can be taught using
Flowol mimics to simulate real-life situations on-screen.  Flowol mimics have been
designed so a whole class can take part at the same time. 

However, a comprehensive understanding of computer control can only really be
achieved by using an interface box, such as FlowGo and a model (either ready-made, or
preferably built by pupils).
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Stand alone computer
For many teachers, using a single stand-alone machine with an interface attached will be
the means of introducing control. In this case more work needs to be done beforehand
with children so that their time on the computer is focused. It is important at this stage for
the emphasis to be on the story-telling and flowchart creation.

Using models
Ready-made models that match the design of mimics, such as the Lighthouse or Car
Alarm are useful in making the link between on-screen simulation and real life control of
products. The advantages of using models is that they are instantly available for use and
that some guidance on developing the flowchart is provided with them. They can be used
for a focused task to develop children’s knowledge, skills and understanding in using the
control software. It should be stressed that ready-made models are meant for use as an
introduction to control. The aim in Design and Technology is for pupil's to develop their
own working models. Pupils should have the opportunity to research, design and make
their own products using their own choice of mechanisms, electrical components and
control systems.
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Moving on – Models with the control system built-in
Have you seen the fridge magnet that meows like a cat, when the door is opened, or the   
small spinning top that plays a tune whilst it spins. 

Pupils at secondary school will be introduced to a whole host of materials to design with;
plastics that can be vacuum-formed and cut, metals that can be folded and welded,
wood, etc. They will also be introduced to electronics. To make the link with the control
that the have used in primary school, Flowol can be used to download a program into a 
programmable chip, a PIC chip. The information from a control flowchart can be saved 
onto a chip which is placed on an electronics board and connected to components such
as LEDs, motors etc. The pupil's model is then completely independent of the computer.
PIC systems enable pupils to design products with a control system that are small and
cheap enough to take home!

Conclusion
Simply making a mechanism that can move is an achievement for pupils. Controlling it for
a purpose, by using a computer, brings it to life and links what children do in school to
their lives outside in a fun, interesting and relevant way.
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2 Motor Green sockets Configured for motors to allow speed control and 
Outputs movement in a forward or reverse position.

Analogue Sensor Inputs Serial and
USB Port

Power Supply socket

Digital Outputs

LED indicator :- 
to show whether an 
output is On or Off.

Motor Outputs
LED indicator :- 
to show whether an 
input is On or Off.

Digital Inputs

Power / Go
indicator light

Go button

6 Digital Red & Black To power 6-volt electrical devices 
Outputs sockets such as bulbs, buzzers, etc.

4 Digital Inputs Yellow & black For switch-type sensors which can
sockets register an On or Off state. 

2 Analogue Jack sockets For level-type sensors capable of                
Sensor at the back of detecting changes in environment such
Inputs the interface as light, temperature, etc.      

Power At the back of To power FlowGo either via the mains
supply the interface power supply or the battery snap
socket supplied.     

A Serial and a At the back of For connecting FlowGo to the computer
USB port the interface either via a serial or a USB lead 

(not both at the same time!).  

A green Power / On the top of To indicate whether FlowGo is being
Go light the interface supplied with power or if a program is

running.                                               

A Go push button On the top of Used to run the Flowol program stored in
the interface FlowGo’s memory.

FlowGo is equipped with:
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What is required?
FlowGo is a control interface. An interface is the link between the computer and the 
electrical components on a model. It provides power for the electrical components and
also acts as a buffer between the components and the computer. In order to use a com-
puter to control these components you need Flowol software. 

• A computer with a free serial or USB port. 

• Flowol software (FlowGo requires Version 2.80 or above).

• The FlowGo control interface.

• A serial or USB connection cable.

• A power source – either use: 
• The mains power supply (supplied with FlowGo) or 
• 4 x size ‘C’ or ‘D’ 1.5v batteries in a 4-cell battery holder and connect via the 

battery snap connector (supplied). 

• A model with electrical components to control.

Setting up for the first time
Turn on your computer. 

Step 1 
If Flowol is not already on your computer, install the Flowol application. For details of 
how to install and operate Flowol, please refer to the Flowol tutorial. 

Step 2
Connect the power supply lead into the socket on the back of FlowGo and plug into 
the mains supply. The green LED indicator should stay on.
Note: if the LED flashes, press the Go button once so it stays on.

Step 3
Connect FlowGo to the computer using either the serial cable - see A or the USB 
cable - see B. 

(A) Using a Serial cable
Insert the serial cable to the serial socket at the back of FlowGo and the other end 
of the cable to the serial port of your computer.

The serial port on a IBM computer can be 
either a 9-way or 25-way D-shaped socket 
and may be labelled as: Serial, COM,RS232 
or

If your computer has more than one serial port, make a note of which port you are
connecting to.
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Using a USB cable and its drivers
1. Insert the square-end plug of the USB cable to the USB socket at the rear 
of FlowGo and the flat USB connector to the USB port on your computer.
Note for Windows 2000 & XP users: the FlowGo drivers need to be installed with administrator privileges.

First Stage:

2. Windows will automatically detect that FlowGo has been 
attached and will try to locate the drivers for it. A wizard will 
be generated to help install the drivers for FlowGo. Click on 
Next.

3. Select ‘Search for the best driver for your device’ and click on
Next. 

4. Insert the ‘USB Driver For FlowGo’ disk (included with the 
USB cable) into the floppy drive on your computer. Select the 
floppy disk drive (a:) as the destination for the wizard to 
search on. Click on Next. 

5. Windows will search and then be ready to install the best 
driver for FlowGo. Click on Next. 

6. A progress bar will indicate that  
the files are being copied. 

7. Once installation of the drivers is complete click on the 
Finish button. Leave the ‘USB Driver For FlowGo’ disk in the 
floppy disc drive until the second stage is completed.

Second Stage:
8. The serial drivers that identify FlowGo as a ‘virtual’ serial device will now need to
install. Some operating systems e.g. Windows 98SE, do this automatically (Windows will
search, update, and install the FlowGo hardware information). Others systems 
e.g. Windows 2000, generate a wizard to aid installation: -

• Select ‘automatically search for a driver’, Next
•    Select that the wizard should search on the floppy drive, Next
•     The wizard will show it has detected a correct driver from the disc, click 

Next to start the installation.
•     When installation is complete, click Finish to close the wizard.  

9. Eject the floppy disc.
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Step 4 
To use Flowol with the FlowGo control interface, it must first be set up from the software. 

Start the Flowol software application.

1. Leave the Simulate option from the Control 
menu ticked until you have made the 
interface and serial port selection. 

2. Select the Interface option from the 
Control menu.

3. Select: 
a. Serial port
b. the appropriate serial connection e.g. COM1  
c. the Model of Interface as FlowGo
d. OK and Save for Flowol to save your selection

so that it will be automatically configured when
next used, or OK for these settings to be used 
for this session only.  

Notes: 
• Some ports will be greyed out to indicate that they 

are not available for selection on your computer.
• If FlowGo is used with a USB lead, it will be seen by 

Windows as a virtual COM device, so you will need to select the COM port that it is has been 
installed to. 

• If you are unsure which number serial port you have used, try each available port in order i.e. Com 1 
first, then Com 2, Com 3 & then Com 4. (See Troubleshooting).

A FlowGo button will appear at the bottom of the toolbar on the screen.

Step 5
Untick Simulate from the Control menu.

Step 6
To check that communication has been established:- 

• Plug an output device e.g. bulb into one of the pairs of output sockets e.g. Output 1 
• Select the Small Monitor window from the Window menu 
• Use your mouse to click on the appropriate output number to switch the output 

device On and Off.

To test an input:- 
• Plug a switch to one of the pairs of input sockets e.g. Input 1. 
• Click so a tick appears in the Test box on the Small Monitor window. 
• Switch the switch to an On position (e.g. if using a push-to-make switch, press the 

button) and watch the box below the relevant input light up when the switch is ON. 

[a]
[b]

[c]

Test box

[d]

Click here
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Using FlowGo after the initial set-up 
• Connect FlowGo to the power supply. The green LED indicator should 

stay continuously lit.
Note: if the LED is flashing, press the Go button once. 

• Connect FlowGo to the computer using the serial or USB cable supplied. 
• Start Flowol. If ‘OK and Save’ was selected during the first set-up, then 

FlowGo will automatically be configured for FlowGo. If not, re-configure Flowol for 
use with FlowGo.   

• Untick Simulate from the Control menu.

Simulate
Control programs can be created, tested and modified in Flowol without the control 
interface attached. This is referred to as ‘operating in Simulation mode’.

To simulate FlowGo: -
1. Leave Simulate from the Control menu ticked.
2. Select Interface from the Control menu.
3. Select the model of interface as FlowGo.
4. Click on OK and Save.
5. Flowol will now simulate the correct number of outputs & inputs and the 

commands available for use with FlowGo. 

Using Outputs and Inputs

Connecting Outputs and Digital Inputs:
The Output and Inputs on the front of FlowGo are 4mm sockets. 

Methods of connecting electrical components include:

1. Using a pair of 4mm plugs fixed to wire cable, which is then 
attached to the electrical component (e.g. as used on the 
components in the Model pack). 
Note: These plugs are often referred to as 4mm Banana or Stackable 
plugs and can have either a solder or screw connection. 

2. Spring Connectors – Product No CK6 – available in packs from Data Harvest. 

The base of a spring connector is a 4mm plug, the top
part is a spring that is pushed back to enable bare
wires from electrical components to be inserted.
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Digital Outputs
Plug an output device e.g. bulb, into a pair of output sockets. 
Note: If buzzers or LEDs are in use, ensure connection to the correct poles 
(see below).

The state of an output socket (On or Off) is shown by the indicator light alongside the 
socket.  When an output is switched ON (the line is HIGH) the LED will be lit.  When the
output is switched OFF (when the line is LOW) the LED will be off. 

Examples of output devices include:

Bulbs and bulb holders.

Buzzers:- connect the red lead from the buzzer to the red 
socket and the black lead to the black socket on FlowGo.  

Small D.C. Motors:- can be connected but will
only give one direction of rotation.

Light Emitting Diodes (LEDs) :- any type can be used. 
For standard LEDs connect a 470ohm resistor in series with the 
LED to protect it from the excess current – alternatively a LED 
with in-built resistor can be used. Connect the long leg of the 
diode to the red socket and the shorter leg to the black socket 
on FlowGo.

The voltage from an Output when powered from FlowGo’s mains power supply is 6 volts.

The total maximum current supplied by the outputs (6 x outputs + 2 x motors) when used
with the mains power supply is 1.3 Amp (1300mA). 

Example:  
• The current required by 6 x 6v (150mA) ordinary MES bulbs is 900mA, which is within the 1300mA 

limit. 
• The current required by 6 x 6.5v (500mA) High Intensity MES bulbs is 3000mA, which exceeds this 

limit. 

The supply for the digital outputs is via a 'resettable' fuse. 
Should the load exceed 1.3 Amps, unplug all the outputs and the fuse will automatically
reset after approximately 60 seconds.
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Motor Outputs
The two Motor Outputs can be used with motors to give movement in either direction
and/or at varying speeds. 

Plug the motor into one of the pairs of motor output 
sockets i.e. into A1 & A2 or B1 & B2. 

Commands in Flowol can be used to 
change the motors’ direction of rotation 
(to turn it forwards or to reverse it).

The speed of a motor can be controlled 
using power commands. If the motor is 
used without power control, it will run at 
full speed.

The voltage to the motor output can be 
pulsed at 10 levels: - 10%, 20%, 30%, 
40%, 50%, 60%, 70%, 80%, 90%, 100%.

Select the Large Monitor window 
from the Window menu in Flowol. 
Switch the motor output on and 
then drag the slider to vary the 
power to the motor output. This
facility is useful when exploring 
a suitable speed for the motor on 
a model  (providing Flowol is not 
in simulate mode!).

It is possible to use a Motor output as an ‘ordinary’ digital output whenever extra outputs
are required. Use ‘Motor’ commands to switch the outputs on and off. 

The command ‘Motor a fd’ will switch the left socket (A1) to negative
and the right socket (A2) to positive (LED indicator goes green). 

The command ‘Motor a rev’ will switch the left socket (A1) to positive
and the right socket (A2) to negative (LED indicator goes red). 

A ‘resettable’ fuse protects each motor pair. Should the load be exceeded, the fuse will
trip. Remove all motor loads and it will automatically reset after approximately 
60 seconds.

Turn
Motor a fd  

Turn
Motor a rev

Motor
b fd 50%

Motor B is turning 
in a forward 
direction at 50%

Click here to 
switch the 
motor on

Motor A is turning 
in a reverse 
direction at 100%

_

_

+

+
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Digital Inputs
There are four digital Inputs for use with switches which can register an On or Off state.
Flowol can decide whether or not to carry out a command or run a procedure according
to the state of the input.

Connect the switch to one of the pairs of 
input sockets (yellow & black). 

Switch the switch to an On position (e.g. if using a push-to-make switch, press the 
button) and watch the indicator LED next to the relevant input on FlowGo light up when
the switch is ON. 

A switch is a break in a circuit, which can be joined whenever 
you wish. Students can make their own switches from everyday 
materials to suit the own particular needs. 

Some examples of the different types of ready-made switches that can be used are:

Push-to-make switch: - when the button is pressed, the contacts connect together 
allowing the current to flow (Input On): when the button is not pushed, the contacts are
open and no current flows (Input Off). 

Light Sensitive switch (phototransistor or LDR):- this switch reacts to brightness. If 
sufficient light is shining at the switch, it passes current and the switch is ON (Input On).
When there is not enough light (e.g. by something being placed in front of the LDR), the
switch will be OFF. This switch is often used in the construction of a light beam barrier.

Bulb placed within a tube
lined with silver foil.

The LDR can be made more
sensitive by placing it within a
tube of black card.

Alarm can be set to go off if light beam is
interrupted (if input alters from On to Off)

Drawing pin
and paper
clip switch.

Is Input 1 on

NO

YES
Is Input 1 off

NO

YES



FlowGo User Guide

16

Tilt switches: - an encased vessel that contains a moving body that makes or breaks a
contact when tilted. Tilt the switch up to activated the switch (Input On): tilt it down = no
current (Input Off). Often used on a car park barrier.

Magnetic proximity or Reed switch: - used in combination with a magnet. When the
magnet gets near, the contacts inside the switch close and the switch is activated (Input
On): no magnet = no current (Input Off). Often used to indicate when a door is open or
closed. 

Pressure mat: - a membrane panel switch sealed inside a PVC pad.  When there is a
load on the pressure mat the switch is activated (Input On): no load  = no current (Input
Off). Often used in a burglar alarm. Check that the sensitivity of the pad is suitable for the
size of the load being used to trigger the switch.  

Sensor Inputs
There are two Sensor Inputs for use with analogue sensors
e.g. temperature and light level. 

Connect an analogue sensor to one of the jack sockets at
the back of FlowGo.  

Select either Large Monitor from the Window menu or Sensors from the Graph menu.
Click on the down arrow next to the appropriate sensor input number and select the type
of sensor from the list. 

N

Test Mode Box.
Sensor list
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To see the current value from the sensor, click so a tick is in the Test Mode box (ensure
Flowol is not in simulate mode!). 

Flowol can decide whether or not to carry out a command or run a procedure according
to the value from the sensor. 

If FlowGo is connected to the computer data is automatically logged whilst a program is
running. To view data from the attached sensors, select Show Graph from the Graph
menu. 

Click on the 
appropriate analogue 
sensor icon in the 
toolbox.  Then click 
in the Graph window 
for the graph of that 
sensor to load. 

You do not need to create a flowchart to log data from a sensor, just load the empty
graph and click on Run. The timespan defaults to 2 minutes, select Time parameters from
the Graph menu to alter. Selecting Values allows a line to be scanned across the graph
to show analogue values. (See the Flowol Tutorial for more information).

Pre-assembled analogue sensors are available from Data Harvest. If you wish to 
assemble your own, see ‘Technical Specifications’. 

To load a graph for 
a second sensor,
select its’ icon from
the Toolbox and
click on the thick
grey line at the 
bottom of the
graph (the gutter).

Light Sensor
- housed

Light Sensor
- unhoused

Rotation Sensor

Temperature Sensor 
- unhoused 

Temperature Sensor
- housed 

Is Val 1 > 20

YES

NO
Is Val 2 < 50

YES

NOIs the value
from the 
sensor greater 
than 20 ?

Is the value
from the 
sensor less 
than 50 ?
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Using FlowGo away from the computer.
There are two distinct modes of operating FlowGo.

1. It can be used connected to the computer and operated as an ordinary real-time 
control interface with the Flowol application performing the processing of a program. 

2. It can run a program that has been created in Flowol whilst away (disconnected) 
from the computer. The Flowol program is stored and processed by a 
microprocessor in FlowGo.

The program is stored in non-volatile memory so even if the power is disconnected 
or turned off, the program will not be lost. When the power has been reconnected, 
press Go and the stored program will run.

The microprocessor in FlowGo can be reprogrammed repeatedly.

Downloading a Flowol program to FlowGo 
Use Flowol to write your control program in the usual manner  - for more details see the
Flowol Tutorial supplied with the Flowol software.

Once the control program has been written and tested, it can be downloaded into FlowGo
as follows 

• Ensure Simulate is unticked and that the control program is not running. 

• Check that FlowGo is connected & powered. If the green indicator LED next to the 
Go button is flashing, press the Go button so it stays on.

• Click on the FlowGo button on the toolbar to initiate 
the download of the control program into FlowGo.

• As the program is compiled into ‘machine code’ and down
loaded into FlowGo, a progress indicator will be shown.

• Upon completion, disconnect FlowGo from the computer.

Running the Flowol program while disconnected from the computer
Attach a power source (mains adaptor or battery) to the FlowGo interface. 

Press the Go button on FlowGo to run the program from start – the green LED will flash
while the program is running. When it has finished running, the LED will stay on.

To interrupt the program whilst it is running (green LED flashing), press the Go button
once. 

FlowGo will hold the compiled program in its memory until a new one is downloaded and
it is overwritten.

18
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Stored program limits
There is room in FlowGo’s memory for 256 bytes of program, which is between 100-200
Flowol symbols (the number depends on the complexity of the program). When creating
a very complicated program on the computer it is possible to exceed this capacity. For
this reason there are limits to the stored program, and they are:-

• Maximum of 4 Starts.
If more than four Starts have been used in a program, then only the first four will be 
downloaded - these will be in order of their addition to the flowchart.

• A maximum of 16 different Subroutines.
Example: If (Sub 2) is used five times in a program, then this is counted as one subroutine. If three 
different subroutines are used e.g. (Sub 1), (Sub 2) and (Sub 3), then these will be counted as three 
subroutines.

• Subroutine nesting to 8 
levels. Flowol cannot check 
for excess levels of 
subroutine. If the limit is 
exceeded, the program will 
appear to download 
successfully but the 
program will not execute 
correctly. 

• No more than 16 different valued Delays. 
Example: If [Delay 2] is used five times in a program, then this is counted as one 
value of delay. If the delays are for different values e.g. [Delay 1], [Delay 2], and 
[Delay 3, then this will be counted as three delays. 

• Up to 16 different definitions of a Variable. 
Example: If [Let x = 0] is used five times in a program, then this will be counted as 
one variable. If [Let x = 0], [Let x = 1], and [Is x = 1] are used then they will be 
counted as three different definitions. 

Note:  Only the variables x & y are available for use with FlowGo. 

If the Delay or Variable limits are exceeded, Flowol will not be able to download the 
program and a ‘compile error’ message will be displayed. 

LEVEL 1

LEVEL 4LEVEL 3
LEVEL 2
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Power Requirements
FlowGo has thermal over current protection and will not be damaged by a short circuit if
powered using the power supply provided with FlowGo. The thermal over current 
protection will also prevent excess current being drawn from the power supply or the 
battery.  

Mains Power Supply
Use the power supply packaged with FlowGo to operate 
it from the mains. It is rated with an output of 
1300mAmp, 6 Volts regulated dc with a positive 
centre & a negative outer pin.

Batteries
FlowGo can be used with a 6-volt battery connected to the power socket using the 
battery clip connector provided. 

We recommend the use of either 4 x size C or 4 x 
size D 1.5v batteries in a 4-cell holder that has a snap 
connector. The length of time that FlowGo can operate
on a set of batteries will vary according to the age, 
condition, make of the batteries, the type of components
and how much current they use.

Examples.
1. We used 4 x 1.5v new Duracell Plus Alkaline ‘C’ batteries to run a program that switched the LEDs on
the Fairground entrance model on and off continuously and it ran for 95 hours. 
2. We used 4 x 1.5v new Duracell Plus alkaline ‘D’ batteries to run a program for a buggy with 2 geared
down motors going backwards and forwards continuously and it ran for 6 hours. 

Safety Notice
Under no circumstances should any part of FlowGo be connected directly or indirectly to any voltage in 
excess of 6 Volts. Any mains powered supply used to power FlowGo must include a low voltage 
transformer to fully isolate this unit from the mains supply. The warranty for FlowGo applies only if it has 
been used with either the power supply provided or with batteries that supply a maximum of 6 volts.

+
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Technical Specifications
Switching the load to ground drives the digital outputs; each output is capable of handling
100mA, with a combined maximum load from the six outputs of 600mAmps.

The motor outputs can source or handle 200mA continuously. A Pulse Width Modulator, 
running at a repetition rate of 62 Hz, controls the power.

Digital inputs are pulled high by an internal resistor and configured such that switching an
input to ground turns the input 'ON'. The maximum 'ON' resistance is 4K ohms and the
minimum 'OFF' resistance is 5K5 ohms. Impedance's between 4Kohms and 5K5 ohms
may produce ambiguous results.

The sensors are driven from a single reference voltage of 2.5 V, which can provide up to
1mA of current for each channel.

Sensor pin connections
The connections to the 3.5mm Stereo Jack Socket are as follows:

To ensure that 'home-made' sensors respond correctly to the calibration tables found in
Flowol, they should be built to the following standards:

Light Sensor
ORP12 (LDR) between VRef. (B) and Signal (C)
2K7 Resistor between Ground (A) and Signal (C)

Rotational Sensor
10K linear pot, track legs to VRef. (B) and Ground (A),
Wiper leg to Signal (C)

Temperature Sensor
100k 6A1 Thermister bead between VRef. (B) and Signal (C)
100k Resistor between Ground (A) and Signal (C)

Environmental Conditions
FlowGo is not waterproof. 

FlowGo is suitable for use in a 0 – 30ºC operating range and 0 - 95% RH 
(non-condensing). 

A

C B

A       O V Ground
B       V. Ref.
C       Signal
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Trouble Shooting
Q. I get an error message ‘ There is a fault with the serial interface. Reset box and 

try again’. This message indicates that Flowol is unable to communicate with the 
control interface attached. 
Note: Flowol does not try to establish communication until you are out of Simulate mode, until you click 
on the Run button, or until you click on an output or Test an input from the Monitor window. 

Check:
1. Is there power to the FlowGo unit? Check to see if the green LED is on.
2. If you are using batteries, disconnect and use FlowGos power supply (the batteries 

may be drained to such a level that whilst there is sufficient power to light the 
green power on LED, there is not enough power to allow communication). 

3. Is the serial/USB lead connected to the serial/USB port on FlowGo? 
4. Is the serial/USB lead connected to the serial/USB port on the computer? 
5. Is the LED next to Go flashing – if so, press the Go button so it stays lit. 
6. Is the serial port/ Interface selection correct? (See below)

Q. How do I know which serial port to select?
1. Make sure Simulate in the Control menu is ticked.
2. Select FlowGo as the Interface from the Control menu. 
3. Start with the first Com port that is available (isn’t greyed out), e.g. COM1.
4. Click on OK & Save. 
5. Deselect Simulate 
6. Open the Small Monitor window from the Window menu in Flowol and click on 

Output 1. 
• If Output 1 on FlowGo lights then your selection is correct. 
• If you get a message to say ‘ There is a fault with the serial interface. Reset 
box and try again’, then repeat the above from Step 1 – 6 but select the next 
Com port that is available. (Make sure Simulate in the Control menu is ticked 
before you begin the selection process).

Q.I have switched the Output on and the device attached is not working: -
1. Does the screen display indicate that the output is switched on?
2. Is the red LED next to the Output lit?
3. Are you still in Simulate mode?
4. Is FlowGo attached to a power source?
5. Is there a loose connection?
6. Is the bulb loose in the bulb holder?
7. Have you connected the leads from your buzzer or LED correctly?

Q.When I select Interface from the Control menu FlowGo is not in the list.
1. Select About from the Help menu. The version number 

of Flowol is on the bottom right side of the flash screen. 
The version number needs to be 2.80 or higher. 

2. If you have an earlier version of Flowol, contact 
Data Harvest for information about an upgrade.  
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Q. I have the Flowol upgrade, but I already have Flowol on my computer. Should I delete
the old version first?

1. Yes. Exit Flowol if it is open. 
2. Select Uninstall from the Start, Programs, Flowol 2 menu.

Q. When I open a Monitor window or a Mimic, I don’t get the right number of outputs 
and inputs available.
1. Go to Interface from the Control menu and check that the interface selected is 
FlowGo.

Q.When I try to download to FlowGo, I get an error message ‘ Failed to connect to 
FlowGo – check connection and try again (Error No 300)’.

1. Is the LED next to Go flashing – if so, press the Go button so it stays lit. 
2. Is FlowGo powered up, and the serial lead connected?

Q.When I try to download to FlowGo nothing happens.
1. Check that Simulate is unticked.

Q.When I run my control program I get a message to say ‘Error parsing decision’.
1. You are downloading a program that has been created using variables other than

those available for FlowGo e. g. (n) 
2. Alter the program using either x or y as the variable. 
3. Alter the Interface selection to FlowGo so that in future the options available 

reflect only those available for FlowGo.

Q.How can I check which serial port the USB driver has loaded to?
1. From the Start menu, select Settings, Control Panel, and 

System Properties.
2. Select the Device Manager tab
3. Select “Ports (COM &LPT).

It will be shown in the list e.g. FlowGo [COM 4]. 

Q.How do I uninstall the USB drivers?
1. The USB lead should not be connected. 
2. From the Start menu, select Settings, Control Panel, and Add/Remove programs  
3. Select the Install/Uninstall tab
4. Select ‘FlowGo USB Drivers’ from the list. 
5. Click on the Add/Remove button. 

Warranty
FlowGo is warranted to be free from defects in materials and workmanship for a period of
12 months from the date of purchase provided it has been used in accordance with any
instructions, under normal conditions. This warranty does not apply if the FlowGo has
been damaged by accident or misuse.

In the event of a fault developing within the 12-month period, FlowGo must be returned to
Data Harvest for repair or replacement at no expense to the user other than postal
charges.
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Assembly Instructions for the Fair Model

The Model comes with all the electrical components pre-wired with colour-coded 
4mm plugs (red and black) to match the Outputs on FlowGo.

The contents of the pack are:-
• A 12-way ribbon cable with 6 coloured light emitting diodes (LEDS), 
• One double-sided sticky pad.
• The model (with its stand) showing a clown at the entrance to the fair.

1. The LEDs need to be fed into the holes from the back of the picture. 
Hold the LED securely just below the diode and push gently into the 
holes (take care not to bend the lead/diode junction). 

2. You may find it useful to label each pair of output plugs to ensure the LEDs ‘match’ 
the labelling for the mimics. Work along the cable from the back of the model from 
left to right.

The red LED is output 1.
The yellow LED is output 2.
The green LED is output 3.
The green LED is output 4.
The yellow LED is output 5. 
The red LED is output 6.

3. Use the double sticky pad (provided) to fix the ribbon cable to the back of the
model.

4. Assemble the stand (see page 30)

Sticky 
Pad

Back of Fair
Model.

Output 6 
Red

Output 5 
Yellow

Output 4
Green

Output 3
Green Output 2 

Yellow

Output 1 
Red
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Assembly Instructions for the 
Lighthouse Model

The model comes with all the electrical components pre-wired with colour-coded 4mm
plugs that match the Output / Inputs on FlowGo - red and black for Outputs, yellow and
black for Inputs.

The contents of the pack are:-
• A 6-way ribbon cable that has one lamp, one buzzer, and a connector, 
• A light dependent resistor (LDR) this has a clear lens through 

which it is possible to see an orange snake-like shape. 
• Two double-sided sticky pads.
• The model (with its stand) showing a lighthouse.

Assembly

1. Push the lamp into the hole from the back of the model until its holder just makes 
contact with the front of the model (take care not to bend the lead junction).

2. Use a double sticky pad to secure the buzzer into position on the rear of the model.
3. Feed the thin metal legs of the light resistor from the front of the model through 

the slot cut in the Sun (see picture A). 

Light
Resistor

Front of
Model

Slot 
into Sun

A

Back of
Lighthouse
Model

Connector for
Light Resistor
(Input 1)

Sticky
Pad

Lamp 
(Output 1)

Buzzer
(Output 2)
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Assembly Instructions for the 
Lighthouse Model

4. Insert the legs from the resistor into the two outer holes on the connector (picture B)

5. You may find it useful to label each pair of plugs to ensure they ‘match’ the labelling 
on the mimics. Work along the cable from left to right from the back of the model;    

The buzzer is output 2.
The lamp is output 1.
The light resistor is input 1.

6. Use a sticky pad to fix the ribbon cable to the back of the model.
7. Assemble the stand (see page 30)

Viewed from 
the top looking
down.

Connector

Legs

Front of Picture

Back of Picture

Light Resistor

B



Assembly Instructions for the Car Model

The model comes with all the electrical components pre-wired with colour coded 
4mm plugs that match the Output / Inputs on FlowGo - red and black for Outputs, yellow
and black for Inputs.

The contents of the pack are:-
• A 14-way ribbon cable that has one red LED, two yellow LEDs, one 

magnetic proximity switch, (with magnet), one buzzer and two push-to-make 
switches, 

• Four double-sided sticky pads, 
• The model (with its stand) showing a car . 
• Rivet and knob for door handle.

Note: You will need scissors to cut the sticky pad and may find a small spanner or pliers useful for 
the push switch assembly. 

Assembly
1. Push the yellow LEDS into the correct holes from the back of the model.
2. Use a double sticky pad to secure the buzzer onto the rear of the picture roughly in 

the position shown.
3. Unscrew the small hexagonal nut and washer from one of the push switches. Push 

the switch into the correct hole from the back of the model. Screw the nut and 
washer into place from the front of the model to secure. 
Note: You should be able to get a sufficiently tight fit using your fingers, if not use a small spanner or
pliers.

4. Repeat with the other push switch. 

Red LED
(Output 1)

Car door
handle
Rivet

Magnetic Proximity
Switch + Magnet
(Input 1)

Push to Make
Switches 
(Input 2)

Yellow LED
(Output 3)

Buzzer
(Output 4)

Sticky Pad

Back of Car 
Model

Yellow LED
(Output 2)

Push to Make
Switches 
(Input 3)

28
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Assembly Instructions for the Car Model

5. Cut one of the double-sided sticky pads to a suitable size for the magnet (20mm x 
6mm). Stick the pad (1) close to the edge of the door on the back of the model as 
shown on sketch A. Stick the magnet onto pad (1).

6. Stick the other sticky pad (2) on the edge of the door frame – keep the pad below 
the hole for the red LED and close to the edge. Press the magnetic proximity switch
on to pad (2). Do not bend the lead/switch junction. 
Note: it is necessary for the magnet and switch to be close together when the door is closed for the 
switch to operate correctly.  

7. Push the red LED into the correct hole from the back of the model. 

8. Insert the plastic rivet into the hole for the door handle. Hold the rivet in position and
fix the handle to the door from the front of the model (as shown in sketch B)

9. You may find it useful to label each pair of plugs to ensure they ‘match’ the labelling 
for the mimics. Work along the cable from the back of the picture from left to right; 

The first push switch is input 3.
The second push switch is input 2.
The buzzer is output 4.  
The magnetic proximity switch is input 1.   
The yellow LED is output 3.
The next yellow LED is output 2.
The red LED is output 1.

10. Use a sticky pad to fix the ribbon cable to the back of the model.
11. Assemble the stand (see page 30)

Hole for 
red LED

Magnet

Magnetic
Proximity
Switch

Sticky pad (2)

Sticky pad cut (1)
cut to size.

Back of Car
Door.

Push together
firmly.

Back of  Car 
Door.

Car Door.

Handle

Rivet

Sketch A

Sketch B

Car door 
cut out
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Assembling the Stand

• Assemble the stand and rear support to the main model slots.

• You are now ready to plug the wires into the Outputs and or Inputs on FlowGo.
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Installing and Opening the Mimics

Installing the Model Pack 1 Mimics.
Note: Flowol2 must be installed on the computer before the mimics can be installed. 

PC Windows:
1. Place the floppy disc labelled ‘Model Pack 1 Mimics’ in drive A.
2. From the Start menu select Run.

(Win 3.1 Users select Run from Program Manager)
3. Type a:setup in the dialogue box and click on OK.
4. Follow the on-screen instructions. The installation utility will automatically search for

the mimic folder that was created when Flowol 2 was installed on your hard disc i.e.
’Mimic folder found at C:DHG\Flowol\Mimics’. Click on OK to install the new 
mimics. 

Note: If a copy of the Flowol program was open (in use) before installation started, exit & restart 
before trying to open the mimic.  

5. When installation has finished eject the Mimic disc.

Opening a Mimic
Start Flowol.

Click on the Window menu and select 
Mimic. Select the appropriate mimic 
from the list.

The names for the mimics in this 
pack have been prefixed by p1.

Tick in the Show labels box to 
view the input/outputs labels.  
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Introducing the Activities

The following teacher's notes and activities are designed to introduce computer control
with Flowol software and the starter models in Model Pack 1. They aim to give a 
progression through the following skills:

• Creating a program that turns a single output on and off.

• Creating a program that turns more than one output on and off.

• Creating a program that runs continuously

• Using an input to start a program.

• Using a sub-routine.

• Repeating a sub-routine for a set number of times.

• Using an input to call up a sub-routine.

• Using more than one flowchart.

• Using more than one input.

• Using inputs to stop, as well as start a sequence of actions.

• How to tackle more complex programs.

These notes and activities have been written to suit primary teachers with pupils aged 
9 – 11, as starter activities for computer control. It is assumed that teachers will have
read the Flowol Tutorial and made themselves familiar with the Flowol program before
starting these activities.

The Teacher's Notes give an overview of the pupil's activity sheet, with teaching points for
each activity, plus example programs for all the challenges. There are suggestions for
extension activities that refer to other Flowol mimics available separately. These 
activities have been included to help those with mixed ability pupils, who wish to set 
further challenges to the achievers or skills practice. A list of the additional Flowol 
mimics are on the following page.

Each Activity Sheet shows several activities, each with an example flowchart, plus 
challenges for pupils to work through independently, or in pairs or groups. 
Each challenge is designed to use the skills taught in the previous activity.
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Introducing the Activities

Additional Flowol Mimics
Primary Mimics Robot Face, Pelican Crossing, simple Railway Level

Crossing and simple Automatic Home

More Primary mimics School Patrol Crossing, Police Car, Fire Engine, 
Water Chute, Kitchen and simple Home Alarm 
System

Secondary mimics Pelican Crossing, Railway Level Crossing, Car Park 
Barrier, Greenhouse and Automatic Home

More Secondary mimics Water Chute (with counter), Kitchen, Home Alarm 
(with keypad), Theme Park Water Flume and Jam 
Factory

Control Pictures Traffic Lights, Burglar Alarm and Washing Machine

Commotion Mimic Disc Clown Face, Giant Traffic Lights, House

Keying into the National Curriculum
The following tables show how Flowol, FlowGo and the Starter models support both the
ICT and Design & Technology Schemes of Work for Key Stages 1 and 2 published by
QCA (Qualifications and Curriculum Authority) for England and Wales.
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ICT Scheme of Work References

Using Flowol, FlowGo and Model Pack 1 to support the use of the ICT Schemes of
Work for Key Stages 1 and 2 published by the Qualifications and Curriculum
Authority (QCA)

ICT Scheme of Work
ICT Unit 4E Modelling effects on screen

What the unit is about :- How Flowol supports. 

Pupils enter instructions to control a screen turtle 
and compare the operation to a floor turtle. They 
learn how to write a procedure that ‘teaches’ the 
computer a new word and will be asked to 
produce particular shapes on screen.

Write a program to control one of the Model Pack 
mimics with Flowol in Simulate mode.

ICT Unit 5E Controlling devices

What the unit is about :- How Flowol, FlowGo and the models support.

Pupils learn how to control simple devices, such 
as buzzers, small motors and lights, using basic 
control boxes. They learn how to control devices 
by turning them on and off according to a set of 
instructions. They will apply this to examples 
such as traffic lights.

The models in Model Pack 1 include simple 
devices such as lights and buzzers, which can be 
turned on and off using a sequence of instructions 
from Flowol when connected to a FlowGo 
interface.

ICT Unit 6C Control and monitoring – What happens when

What the unit is about :- How Flowol, FlowGo and the models support.

Pupils learn how to use input devices or switches 
to control a process. They learn that it is possible 
to attach devices such as pressure pads, light 
sensors, on/off and magnetic switches etc to a 
control box. Programs can then be written to 
carry out a process.

The Lighthouse model has a light sensitive switch. 
A program can be written so that the lighthouse 
only flashes when it is dark.
The Car Alarm model has three input devices, one 
on the car door, and 2 push button switches on the
key. A program can be written that makes the 
alarm sound if the car door is opened. The buttons
on the key can be programmed to turn the alarm 
system off and on.  

ICT Year 7 Unit 6 Control: input, process and output

What the unit is about :- How Flowol, and FlowGo supports.

Pupils learn about control through modelling the 
working of a carpark barrier. Pupils program a 
simple cause and effect model e.g. pressing an 
input switch that produces an output, and then 
develop their knowledge by using procedures 
as building blocks.

Using the Car Park Barrier from the Flowol 
Secondary Mimics pupils can write a program with 
sub-routines to control the barrier with Flowol in 
Simulation mode.
A 3D model barrier could be built with switches 
and a motor to be controlled using FlowGo. 

See also the Fischertechnik Control Kit 
models available from Data Harvest.
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Design and Technology Scheme of 
Work References

Using Flowol, FlowGo and Model Pack 1 to support the use of the D&T Schemes of
Work for Key Stages 1 and 2 published by the Qualifications and Curriculum
Authority. (QCA)

Design and Technology Scheme of Work.
D&T Unit 4D Alarms

What the unit is about :- How Flowol, FlowGo and the models support.

Pupils develop an understanding of simple 
electrical control through the designing and making
of an alarm system to protect a valuable artefact, 
which has been brought into the classroom. They 
are also introduced to the idea of feedback.

An alarm system can be designed for the Car 
model to protect it from theft, and a Flowol 
program written to register whether the car door is 
open or shut by using a proximity sensor as 
feedback.

D&T Unit 4E Lighting it up

What the unit is about :- How Flowol, FlowGo and the models support.

Pupils apply knowledge about electric circuits 
that they have acquired in science to design and 
make something that will shine light for a specific 
purpose. ICT can be used for research and to 
control their light, switching it on and off when 
required.

Pupils can create a program for the Fair model, to 
switch lights on and off to make an attractive 
display.
Pupils can create a program to control the 
Lighthouse model, using the light switch to detect 
when it is dark so that the light flashes as a 
warning to ships at night.

D&T Unit 6C Fairgrounds

What the unit is about :- How Flowol and FlowGo supports.

The focus of the unit is for pupils to design and 
make a model of a fairground ride, but it could be 
adapted to suit any product in which an electric 
motor produces rotating movement, which is then 
transferred using belts and pulleys.

Motors, when connected to FlowGo, can be 
controlled both forwards and backwards at various 
speeds. This enables pupils to design a ride that 
starts slowly, and builds up to full speed, before 
slowing down again.   

D&T Unit 6D Controllable Vehicles

What the unit is about :- How Flowol, and FlowGo supports.

As an alternative to fairgrounds, the focus is for 
pupils to design and make a model of a vehicle  
in which an electric motor produces rotating 
movement, which is then transferred using belts 
and pulleys, then can be controlled using  
computer control.

Up to two motors, when connected to FlowGo, can
be controlled both forwards and backwards at 
various speeds. 
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Key Skills

Where Flowol and FlowGo support the development of the 6 Key Skills.
Communication:   

• When working with a partner or in small groups, pupils will need to communicate their
ideas verbally, in writing, and then in the form of an on-screen flowchart. Pupils could
then explain (verbally) what they have done, and how they have approached a 
problem by talking to a larger group or the whole class.

• Pupils will develop and refine ideas and make things happen by planning and giving
instructions to make a device work (e.g. when devising a procedure to operate lights).

Application of number:
• Pupils will work with mathematical models when producing flowcharts and sequences

of instructions for controlling mimics and actual components/models.
• Pupils will consider and use units of time (seconds and parts of seconds), for 

example when planning how long devices should stay ‘on’ or ‘off’.

Information technology:
• Through the programmes of study for ICT pupils will have opportunities to develop 

their knowledge, skills and understanding in relation to developing ideas and making
things happen. Specifically pupils will have opportunities 

• ‘To create, test, improve and refine sequences of instructions to make things 
happen and to monitor events and respond to them.’

• ‘To use simulations and explore models in order to answer ‘What if … ?’ 
questions, to investigate and evaluate the effect of changing values and to 
identify patterns and relationships.’ 

National Curriculum (2000)
Working with others:

• When working in pairs or as part of larger groups, pupils will have opportunities to 
develop their social skills: specifically cooperation, and consideration of the views of
other members of the group. 

Improving own learning and performance:
• When planning and producing sequences of instructions for controlling mimics or 

actual components, pupils will review, modify and evaluate their work as it 
progresses

• Through systematic use of the program, pupils will develop their knowledge, skills and
understanding in many aspects of ICT, and also in D&T when actual working products
are controlled.

Problem solving:
• Pupils will have opportunities to consider and work through realistic situations and 

develop a variety of solutions to problems (e.g. devising a car alarm which triggers 
when the car door is opened). This includes: developing skills to identify and under 
stand a problem (e.g. because of the risk of theft, cars need to be effectively 
protected); planning ways to solve the problem (different options inc - pressure pads,
light sensors); monitoring progress in tackling the problem (is my solution working 
yet?); and reviewing solutions to the problem (how well does my solution work?).
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The Fair Model and FlowGo
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Teacher’s Notes for the Fair Mimic & Model

Resources:
Flowol software
Fair mimic from the Model 1 Mimic disc
Fair model 
FlowGo control interface

Software checklist:
1. Load Flowol.
2. Select the Mimic option from the Window menu. Select the p1-fair mimic and ensure

the Show Labels box is ticked. 
3. Ensure that the selected interface is FlowGo (using Interface from the Control menu).
4. If you are using the Fair mimic only, stay in Simulation mode. If you are using with 

the fair model attached to FlowGo, untick Simulate.

Fair Model
The Fair model has a display of 6 lights above the entrance to a fairground.
Connect the model to FlowGo and check that the numbering of the outputs matches those
on the mimic.

Learning objectives/outcomes 
Pupils will learn:

• That a computer can be given instructions (programmed) to carry out a sequence of
actions.

• How to create a program that turns outputs on and off.
• How to create a program that runs continuously.
• That a program can be edited.

Extension activities – Pupils will learn about the use of sub-routines.

Activities

Activity 1 Explore the Fair mimic
• Show how the outputs respond on the mimic and the model.

Activity 2 Switching one light on and off.
• Introduce the Flowol symbols and what they do.
• Show how to select and place the symbols on the screen.
• Show how to select the instructions from the Prompt Box.
• Show how to link the symbols together using the Arrow tool.
• Show how to run a program.
• Show how to save this program, and call it Flash.
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Teacher’s Notes for the Fair Mimic & Model

Activity 3 To make the light flash all the time
• Erase the Stop symbol. Show how to use the 'Helping Hand' to highlight a symbol, 

and how to erase.
• Click on the arrow (the line tool) and connect the Delay 2 at the bottom of the 

flowchart to the first action symbol (Turn Output 1 on)
• Run the program and ask the pupils to describe what is happening.
• Emphasise that the program is running in a LOOP.
• Save the changed program as Flashes

Activity 4 To turn more than one light on and off at the same time.
• Show how to use the ‘Helping Hand’ tool to highlight the symbol to be changed 
• (Turn Output 1 on).
• In the Prompt Box, click on the Clear button, and put in new instructions (Turn Output

1 on, 6 on, then OK).

The Helping Hand Click on the helping hand, click on the item in the
flowchart (it will change colour).

Erase tool After using the helping hand to select the item, 
click on erase to delete. 

To select a symbol from Use the mouse to click once on the symbol (click
the toolbar and release). Move the mouse to the right. The

symbol will appear in the workspace, click to place
it in the required position. 

Start This symbol is used to start or stop a program.

Output or Action symbol This symbol is used to switch outputs on or off.

Process (Delay) symbol This symbol is used to make the program wait 
(delay) before going on to the next instruction.

Arrow or Line This arrow is used to link the symbols together to 
show the order in which each symbol (instruction) 
should be carried out 
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Teacher’s Notes for the Fair Mimic & Model

Challenges
A sample program is included for each challenge on the Activity Sheet. These samples are
for guidance only, as there is always more than one way to write the program!

Output
3,4 on

Delay 1

Output
3,4 off

Start

Output
1,6 on

Delay 1

Output
1,6 off

Output
2,5 on

Delay 1

Output
2,5 off

Start

Output 1 on

Delay 1

Output 1 off

Delay 0.2

Challenge 1: Change the delay instructions
so that the light will stay on longer than it is
off. 

Challenge 2: Create a program to flash
the two red lights on and off, then the
two green lights on and off, and then
the two yellow lights on and off.

Challenge 3: Create your own light display.

Tip: A Delay can be as short as 0.1 second.
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Teacher’s Notes for the Fair Mimic & Model

Extension Activity Challenges: 
Return to the Fair model after introducing sub-routines with the Lighthouse model for the
final challenges.

1. Using sub-routines to repeat a set of instructions 
Instead of writing a long list of on/off instructions to flash the lights, a sub-routine can be
created to flash the light once, called Flash1. This Flash1 sub-routine can be then be called
from the main program and run 3 times.

Step 1: Create a sub-routine
• Select the Start Symbol
• In the Prompt Box, click on Sub.
• Type the name Flash1 in the text 

box, and then click on OK.
• Copy the instructions shown

Step 2:  Using the sub-routine in the main program
• Select Start
• Select the Process (Delay) Symbol.
• Click on Sub and select 1(flash1)
• Click on the number 3, OK 
• Select Stop
• Link up the flowchart.

Save this program as 3flashes

Ask the pupil to run the program and watch the mimic.
Ask if the lights flash 3 times, then ask them to watch the symbols and observe how the
program performs.

Challenge 4: Create a flashing light display with the red lights flashing twice, then the 
yellow lights 3 times, then the green lights twice - make it run continuously.  

Sub 1(Red)

StopStopStop

Output
1,6 on

Delay 0.2

Output
1,6 off

Sub 2(Yellow)

Output
3,4 on

Delay 0.2

Output
3,4 off

Sub 3(Green)

Output
2,5 on

Delay 0.2

Output
2,5 off

Start

Sub 
2(Yellow) x 3

Sub 
1(Red) x 2

Sub 
3(Green) x 2
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Teacher’s Notes for the Fair Mimic & Model

Challenge 5: Program the lights to represent a ball being thrown from the Clown's left 
hand to right hand, and then back again.

Start

Sub 1 (l-r)

Sub 1 (l-r)

Output
1 on 6 off

Delay 0.5

Output
2 on 1 off

Delay 0.5

Output
3 on 2 off

Delay 0.5

Sub 2 (r-l)

Main program

ball goes from left to right

Sub 2 (r-l)

Output
6 on 1 off

Delay 0.5

Output
5 on 6 off

Delay 0.5

Output
4 on 5 off

Delay 0.5

ball goes from right to left

Output
3 on 4 off

Delay 0.5

Output
2 on 3 off

Stop

Delay 0.5

Output
1 on 2 off

Delay 0.5

Stop

Output
4 on 3 off

Delay 0.5

Output
5 on 4 off

Delay 0.5

Output
6 on 5 off

Delay 0.5
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2. Simple on/off activities using other available mimics (see page 33)
Bridge Lights - Create a traffic light sequence.
Robot Face - Make the eyes open and shut. Make the mouth open and shut, and make the
aerial rise and lower.
School Patrol Crossing - Make the sign flash.
Police Car and Fire Engine - Make the lights flash.
Clown Face - Make the eyes wink and then blink.
Traffic Lights - Create a traffic light sequence.

Cross-curricular links:
Literacy - Stories about fairgrounds
Science - Simple electrical circuits
Design & Technology (Primary) - Designing any display of lights e.g. Celebrations,
Christmas tree lights, Festivals, Diwali, Bonfire night, Advertising displays, Street illumina-
tions, creating a book display, etc.
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Activity Sheet

Activity 1: 
Explore the Fair mimic
Click on the lights over the 
fairground entrance to turn 
them on and off.

Start

Turn
Output 1 on

Delay 2

Turn
Output 1 off

Delay 2

Stop

One flash

keep the light on 
for 2 seconds

keep the light off 
for 2 seconds

Activity 2:
Switching one light on and 
off
You are going to create a 
simple program to switch the
light on, keep it on for 2 
seconds, and then switch it 
off. 

To run your program, click on
the red RUN button.
Save your program and call it
flash.
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Activity Sheet

Challenge 1:
Change the delay instructions so that the light stays on for longer 
than it is off.

Start

Turn
Output 1 on

Delay 2

Turn
Output 1 off

Delay 2

Activity 3: 
To make the light flash all the time
Change your program flash.  See below: -

Run your program. What happens?
You will have to click on the red STOP button to stop the program 
running.
Save the changed program as flashes.



Activity Sheet

Challenge 2: 
Can you create a program to flash the two red lights on and off, then
the two green lights on and off, and then the two yellow lights on and
off? It should run all the time.

Challenge 3: 
Create your own light display.

Extension Activity Challenges:

Challenge 4:
Create a flashing light display that flashes the red lights twice, the 
yellow lights 3 times, then the green lights twice. The program should
run all the time.

Challenge 5:
Can you program the lights to represent a ball being thrown from the
Clown's left hand to right hand and then back again?

Start

Output 
1,6 on

Delay 1

Output 
1,6 off

Delay 0.2

Activity 4: 
To turn more than one output 
on or off at the same time
Change your program so that 
it looks like this: -  

46
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The Lighthouse Model and FlowGo
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Teacher's Notes for the Lighthouse 
Mimic & Model

Resources: 
Flowol software
Lighthouse mimic from the Model 1 Mimic disc 
Lighthouse model 
FlowGo control interface

Software checklist
1. Load Flowol.
2. Select the Mimic option from the Window menu. Select the p1-light mimic and ensure

the Show Labels box is ticked. 
3. Ensure that the selected interface is FlowGo (using Interface from the Control menu).
4. If you are using the Lighthouse mimic only, stay in Simulation mode. If you are using

with the Lighthouse model attached to FlowGo, untick Simulate. 

Lighthouse Model
On the Lighthouse model, the lighthouse lamp is Output 1 and Output 2 is the foghorn
(buzzer). There is a light sensitive switch (Input 1) that is used to detect whether the sun is
shining or not. Connect the model to FlowGo and check that the numbering of the 
outputs/inputs matches those on the mimic.

Learning objectives/outcomes 
Pupils will learn:

• that a computer can be given instructions (programmed) to carry out a sequence of 
actions.

• that feedback from an input signal can be used in a program to decide whether to 
carry out a set of instructions or not.

• that a program can be divided up into sub-routines and repeated for a set number of
times.

• to develop a system that can control events in response to conditions.

Activities
Activity 1 Exploring the lighthouse model and mimic

• Show that clicking on the mimic switches on and off outputs to both the mimic and the
model.

• The yellow indicator LED situated next to Input 1 on FlowGo will be lit when light is 
reaching the light sensitive switch. Show the change to the input when the light switch
is covered up i.e. when it becomes dark.
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Teacher's Notes for the Lighthouse 
Mimic & Model

Activity 2 Using a switch as an input signal

Introduce the Decision symbol and demonstrate the Yes and No logic. The example 
program is annotated to help explain the decision process.

• If the sun is shining (the input is ON), then the program keeps 
looking again and again at the state of the input.

• If the sun is not shining (the input is OFF), then the program 
follows the instructions to flash the lighthouse lamp.

See the following examples and the Flowol Tutorial for more information on using the
Decision symbol.

Activity 3 Making the lighthouse repeat a flashing light pattern - introducing 
sub-routines.
The purpose of this activity is to show pupils how to break up a very long string of 
instructions into short, manageable sub-routines. Sub-routines can be called from the
main program and instructed to run just once or repeated a set number of times.

Decision box Used to check for feedback from an input 
signal

Yes / No Lines Where a decision box has been used, 
then both a Yes and a No line have to be 
selected.

Start

Is Input 1 off

NO
YES

Turn
Output 1 on

Turn
Output 1 off

Start

Is Input 1 off
NO

YES

Turn
Output 1 on

Turn
Output 1 off

Start

Is Input 1 off
NO

YES

Turn
Output 1 on
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Teacher's Notes for the Lighthouse 
Mimic & Model

The example programs the lighthouse lamp to give 2 long flashes then 3 short flashes,
whenever it is dark.

Step 1: Create a sub-routine
• Select the Start Symbol
• In the Prompt Box, click on Sub.
• Type the name long in the text box, 

and then click on OK.

Step 2: Create a second sub-routine
• Select the Start Symbol
• In the Prompt Box, click on Sub.
• Type the name short in the text box, and then click on OK.

Step 3: Create the main program

When selecting the sub-routines:
• Select the Process (Delay) Symbol

• Select Sub 1(long) then click on the 
number 2 and OK.

• Select Sub 2 (short) then click on the 
number 3 and OK.

• Link up the flowchart as shown.

Save this program as Rocky.

Ask the pupils if the lighthouse flashing sequence looks effective. Then ask them to
watch the symbols and observe how the program performs.
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Teacher's Notes for the Lighthouse 
Mimic & Model

Extension activities/Challenges
A sample program is included for each challenge. These are intended as guidance only,
there is always more than one way to write a program!

Start

Turn
Output 1 on

Turn
Output 1 off

Delay 1

Delay 2

Start

Turn
Output 1 on

Delay 3

Turn
Output 1 off

Delay 0.2

Is Input 1 off
NO

YES

Turn
Output 1 on

Delay 0.2

Turn
Output 1 off

Delay 0.2

Turn
Output 1 on 

Delay 0.2

Turn
Output 1 off

Delay 2

Challenge 2:
Create a new program to flash the 
lighthouse when the sun is not shining. 
The light sequence should be 1 long 
flash then 2 short flash.

Challenge 1    :
Create a simple program that flashes 
the light on and off all the time. This 
program will utilise the skills learned in 
the Fair Activity. 
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Teacher's Notes for the Lighthouse 
Mimic & Model

Challenge 3:
Create a program that, when the sun is not shining, sounds the foghorn once after every 5
flashes of the lighthouse. 

Other Extension Activities:
Using sub-routines in programs using other available mimics (see page 33).
Pelican Crossing – flashing amber light
Robot Face - making the eyes wink and the mouth open and shut
Simple Level Crossing – flashing lights
Fire Engine – flashing lights
Simple Home Alarm System – flashing light as part of the alarm sequence

Cross-curricular links:
Literacy - Lighthouse Keeper stories

Science - Making simple circuits with a bulb and a switch.
Night and day studies

Design & Technology (Primary) - Designing with found or reclaimed materials and
incorporating a simple electrical circuit e.g. vehicle with warning light, torch/beacon with a
light sensitive switch, advertising display that is triggered by a pressure mat etc.

Start

Sub 2(horn)

Is Input 1 off
NO

YES

Sub
1(flash) x 5

Sub 1(flash)

Turn
Output 1 on

Delay 1.5

Turn
Output 1 off

Delay 1

Stop

Sub 2(horn)

Output
1,2 on

Delay 1.5

Output 
1,2 off

Delay 1

Stop

lighthouse flash foghorn

and flash
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Activity Sheet

Challenge 1:
Create a simple program that flashes the light on and off all the time.

Activity 1:
Exploring the lighthouse
model and mimic
Try clicking on the lighthouse 
lamp and beside the foghorn on 
the mimic. What happens?
Cover the light sensitive switch 
(sun) on the model. Does the 
LED next to Input 1 on FlowGo 
change when the switch is 
covered?

Is Input 1 Off
(Is it dark? Is the sun NOT shining?)

No – Its still light (the sun is shining) 
so keep checking.

Yes – run the instructions to flash the lamp.

Save this program and call it Dark1.

Activity 2: Using a switch as an input signal.

Start

Turn
Output 1 on

Delay 2

Turn
Output 1 off

Delay 1

Is Input 1 off
NO

YES
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Activity Sheet

Challenge 2:
Change your program to flash the lighthouse when the sun is not shining.
The light sequence should be 1 very long flash then 2 short flashes. 

Activity 3 Making the lighthouse repeat a flashing light pattern –
introducing sub-routines.

Create sub-routine long1 first.
Then create sub-routine short2.
The main program should run sub-routine 1 once, and repeat sub-routine
2 twice.

Challenge 3:
Can you create a program that sounds the foghorn once after every 5
flashes of the light, only when the sun is not shining?

Start

Sub 
2(short2) x 2

Is Input 1 off
NO

YES

Sub
1 (long 1)

Sub 1(long 1)

Turn
Output 1 on

Delay 2

Turn
Output 1 off

Delay 1

Stop

Sub 2(short 2)

Turn
Output 1 on

Delay 0.5

Turn
Output 1 off

Delay 0.5

Stop
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The Car Model and FlowGo
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Teacher’s Page for the Car Alarm Mimic & Model

Resources:
Flowol software
Car mimic from the Model 1 Mimic disc
Car model 
FlowGo control interface

Software checklist:
1. Load Flowol.
2. Select the Mimic option from the Window menu. Select the p1-Car mimic and ensure

the Show Labels box is ticked. 
3. Ensure that the selected interface is FlowGo (using Interface from the Control menu).
4. If you are using the Car mimic only, stay in Simulation mode. If you are using with 

the car model attached to FlowGo, untick Simulate. 

Car Model
The Car model has:
Light on wing mirror – Output 1
Left Headlight – Output 2
Right Headlight – Output 3
Horn – Output 4 
Car Door switch – Input 1
Key button – top – Input 2
Key button – bottom – Input 3 

Learning objectives/outcomes
Pupils will learn:

• that a computer can be programmed to monitor a system.
• how to use an input signal in an alarm system.
• that a complex system can be broken down into manageable parts.
• to develop a system that can control events in response to conditions.
• to use input and output devices and produce a simple set of instructions linking 

causes and effects. 

Activities
Activity 1 Exploring the car model and mimic

• Show that clicking on the mimic causes outputs to switch on and off on both the 
mimic and the model.

• Show the effect of opening and shutting the car door (Input 1 is on when the door is
shut so the yellow LED on FlowGo will be lit).
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Teacher’s Page for the Car Alarm Mimic & Model

To show the change in state of the inputs (with the model connected to FlowGo):  
• Open the Small Window (from the Window menu). Click so a tick appears in the Test

box.
• Press the button of the push-to-make switches on the key (to switch it ON) and watch

the box below the relevant input light up. 
• The box below Input 1(the car door) will be lit if the car door is shut (Input On). 

Activity 2 Using more than one flowchart 
This activity introduces the concept of an emergency stop. Using the Stop All command in
the second flowchart stops the program running and switches everything off.

Test box

Sub 1(Warning)

Output
2,3 on 4 off

Delay 1

Output
4 on 2,3 off

Delay 1

Stop

Start

Is Input 1 off
NO

YES

Sub
1 (Warning)

check car door

Flash the lights and sounds the horn if the car door is opened

Delay 2

Start

Is Input 3 on
NO

YES

Stop All

Turn the alarm off if the key is pressed
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Teacher’s Page for the Car Alarm Mimic & Model 

Activity 3 Planning a complete car alarm system.
This activity guides pupils through breaking down a control system into separate actions
(sub-routines). This program should be planned out first on paper. This plan can then
become the design specification, against which the final program can be appraised.

Example

Plan of the Car Alarm system
• The program should continuously check to see if an alarm has been set (has the top

switch on the key been pressed?). 
• When the alarm has been set pressing on the bottom switch on the key should 

deactivate it.
• The alarm needs to activate if the door is opened. 
• If the alarm has been triggered it should continue until the bottom switch on the key 

has been pressed. 
• Shutting the car door should not deactivate the alarm.

Sub-routines needed (these should be created first):

The sub-routine Armed may need some explanation, as there are two inputs to check. 
1. If the door is open (Input 1 Off) then run the Alarm sub-routine, until the Alarm Off 

button (Is Input 3 On) is pressed. 
2. If the Alarm Off button is pressed (Is Input 3 On) then disarm the system.

The main program should continuously check to see if the top switch on the key (input 2)
has been pressed and then activate the alarm.   

Sub-routine name

Flash the indicators once (turn on, one second Flash
delay, turn off).

Sound the buzzer and flash the indicators to show Alarm
the alarm has been triggered (on, half a second delay, off).

If the door is open activate the alarm (ALARM). If the door Set It
is closed, indicate that the alarm has been set by the 
indicators flashing twice (FLASH x 2).

Turns the alarm status light on. Checks the door. Armed
• If the door is shut check for the bottom switch on the key 

to be pressed (DISARM). 
• If the door has been opened activate the alarm (ALARM). 

Keep the alarm running even if the door is then shut until 
the bottom key is pressed (DISARM).

Show the alarm is switched off by one long flash of the Disarm
indicators (FLASH) and switching the alarm status light off.
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Extension Activities/Challenges

Challenge 1:
Create a program that flashes both indicator 
lights on and off.
This is a simple activity using the same skills 
as learned in the Fair 
activity.

Challenge 2:
Create a simple alarm program. 
The indicator lights should flash and
the horn sound if the car door is opened. 
The alarm should continue, 
even if the door is closed again.

The solution should include the use of a 
sub-routine (as in Activity 3 of the Lighthouse) 
but there is another solution that works -
see Car Challenge 2b 

Sub 1(Warning)

Output
2,3 on 4 off

Delay 1

Output
4 on 2,3 off

Delay 1

Stop

Start

Is Input 1 off
NO

YES

Sub
1 (Warning)

check car door

Flash the lights and sound the horn if the car door is opened

Start

Output 
2,3 on

Output 
2,3 off

Delay 1

Delay 1
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Teacher’s Page for the Car Alarm Mimic & Model

If pupils produce this type of program, show 
them how to edit their program to create a 
sub-routine for the flashing lights and horn 
(Alarm).  Pupils will need to be able to use a 
sub-routine in order to complete the other 
activities.

Challenge 3:
Can your Car Alarm program be improved so that it can respond instantly to the Alarm
Off button?

Cross-curricular links:
Literacy - Crime stories.

Numeracy - Logic. 

Design & Technology - Design a house alarm using a cardboard box and a selection of
switches to detect windows and doors being opened, or some
one standing on a mat.

Design an alarm system for a valuable item e.g. jewel, museum
exhibit, etc.

Output
2,3,4 on

Delay 1

Output
2,3,4 off

Delay 1

Start

Is Input 1off
NO

YES

Delay 2

Challenge 2b
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Challenge 1:
Create a program that flashes both indicator lights on and off. Save
your program as car1.

Challenge 2:
Create a simple alarm program. The indicator lights should flash and the
horn should sound if the car door is opened. The alarm should continue,
if the door is closed again.

Tip! If using the mimic only, remember when you run your program
shut the car door before setting the alarm.  Save your program as car2.

Activity Sheet        

Activity 1:
Exploring the Car model and mimic

Use the mouse to click on the 
indicator lights (output 2 and 3) 
and switch them on and off. 
Click on the wing mirror 
(output 1) to switch the alarm 
status light on and off.

From the Window menu select the 
Small Monitor and ensure Test box is 
ticked. 

Press the push buttons on the key and see the change on the 
mimic and in the box below input 2 and 3 on the small monitor 
window. 
Open the car door on the model. Look at input 1 on FlowGo and 
the box below input 1 on the small monitor window. Is the car 
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Activity Sheet

Activity 2:
Using 2 flowcharts 
The lower button on the key (input 3) is used to turn the car alarm 
off.
Flowol can run more than one flowchart at the same time. The 
second flowchart is used to check if the key button (input 3) has been
pressed. 

The command Stop All is used to stop the whole program running 
and switch everything off.

Add this second flowchart to your program, car2.

Run the program and trigger the alarm by opening the car door. 

Press the lower button on the key. Did the alarm stop?

Save this program as carkey

Sub 1(Warning)

Output
2,3 on 4 off

Delay 1

Output
4 on 2,3 off

Delay 1

Stop

Start

Is Input 1off
NO

YES

Sub
1 (Warning)

check car door

Flash the lights and sound the horn if the car door is opened

Delay 2

Start

Is Input 3 on
NO

YES

Stop All

Turn the alarm of if the key is pressed
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Activity Sheet

Activity 3:
Planning a complete car alarm system.
The ultimate challenge is to design a program that is running all the 
time.
This program shows a car alarm system that is set by pressing the 
Alarm On button on the key, and is disarmed by pressing the Alarm 
Off button. Once the system is set, opening the car door triggers 
the alarm, making the horn sound and the indicator lights flash. 
The alarm can only be switched off by pressing the Alarm Off 
button.

To plan this program, write a list of the sequence of actions required.

Example:

Main Program - checks for input 2 to be ON then sets the alarm.

Sub-routine  Sub-routine Action
Name

1 Flash Single flash of both indicators with a 1 second 
delay to be used when alarm is set, and when 
the alarm system is switched off.

2 Alarm Sound the horn and flash both indicators on and
off once with half a second delay.  

3 Set it Check if door is shut, run Flash twice, then run 
Armed.  

4 Armed Turn the alarm status light on. Check the door
• If opened, run alarm then check key button

*See and if it is pressed, run Disarm. 
example Keep running alarm if key is not pressed.

• If the door is not opened, check key for 
button press, if not pressed, recheck door.

5 Disarm Run Flash once, and turn the status light off. 
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Save your program as CarAlarm.

Sub 1(Flash)

Output
2,3 on 

Delay 1

Output
2,3 off

Delay 1

Stop

Start

Is Input 2 on
NO

YES

Sub 3
(Set it)

Sub 4
(Armed)

Sub 2(Alarm)

Output
2,3,4 on 

Delay 0.5

Output
2,3,4 off

Delay 0.5

Stop

Sub 3(Set it)

Is Input 1 on
NO

YES

Sub
1(Flash)x2

Stop

Sub 2
(Alarm)

Sub 4(Armed)

Turn
Output 1 on

Turn 
Output 1 off

Stop

check
door

Is Input 1 off

YES

Sub 2
(Alarm)

Is Input 3 on

Sub 
5(Disarm)

YES

checks key button

Is Input 3 on
NO

YES

Sub 5
(Disarm)

Stop

NO

check key button

Sub 5(Disarm)

Stop

Sub 1(Flash)
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Try your program. 

You may find that if the alarm has been triggered you have to hold down
the Alarm Off button for some time to stop the alarm system. Can you
explain why? 

Challenge 3: 
Can you improve on your Car Alarm program so that it can respond
instantly to the Alarm Off button?


